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Course Overview
Welcome to Preparation of Digital
images using media technologies
In this block, you are going to study about the software
and tools and techniques used in the software to create a Graphic
Design. The design works which used to be done manually in the
old era, using pencil, paint and brush, are being replaced by
modern computers on which we can draw or make anything with
the help of different softwares. Now the computer hard disk
works as the canvas and softwares work as various types of paints,
pencil or charcoal.
You will learn about different kinds of professional project
works which are done in the industry using these softwares.

Working with digital images
In order to work with the digital images we must be clear with
some basic features as about the fundamental unit of a digital
image that is pixels, and arrangement of these pixels are done into
arrays and now further these arrays are organized into single or
multiple layers. In this course, we shall know about the pixels,
arrays, and layers to have an understanding together how they
make a digital image.

Managing file formats for kImages
Whatever image or picture we share or get is present in
the form of a file, and file shave a huge range or variations of
different formats. Some of the file formats that compress the
image also reduces its quality and degrades it. But some time
choosing a wrong file format may increase the size of file the
significantly that is not required.
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Image Editing with GIMP
Gimp is a freely distributed piece of software suitable for
such tasks as photo retouching, image composition and image
authoring. It is an extremely capable piece of software with many
capabilities. It can be used as a simple paint program, an expert
quality photo retouching program, an online batch processing
system, a mass production image renderer, an image format
converter and more.

Technique behind Visual effects
Visual effects involve the integration of live-action footage
and generated imagery to create environments which look
realistic, but would be dangerous, expensive, impractical, or
impossible to capture on film. Visual effects are processes used to
manipulate imagery world which is manipulated in postproduction
house.
This video will provide a brief overview of this course.

Topic
Video 1 –Pipeline

Methodology in Graphics
Industries

Video 2 –Image Editing

Video 3 –VFX Production

Designing

4

YouTube link
https://youtu.be/Q_mzxf_
YIiE

https://youtu.be/SyKuDoId
4KU

https://youtu.be/29CuMFf
dz7Y

QR
Code
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Course outcomes
Upon completion ofPreparation of digital images using media
technologiesyou will be able to:


Outcomes

Understand the structure of digital images, pixel, greyscale
and colour images
Understand the basics of image file formats



Blend two different exposures of the same scene combined
to get the best parts of both images.



Learn about Computer generated Imagery CGI
Learn importance of visual effects shots



Timeframe
This course will be completed within “2” classes.
This course is of “2” credits.
4 Hours of study time is required for this unit.
How long?

Study skills
This is a combination of theory and practical.
Hence, you should have access to personal computer or personal laptop
for better understanding of this unit.
Each and every option is explained step by step in the course material.
Apart from this course material, the learner has to adopt the tendency
of learning from multiple sources i.e.;
Internet tutorials
Video tutorials on YouTube
Collaboration with people working in the industry etc.
Only classroom study will not make you a professional. You have to be
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active to grab the opportunity of learning wherever you get a chance.

Need help?
In case of any help needed you can browse the internet sites like
youtube.com for video tutorials about the subject.
Help

Assignments
There will be some assignments are the end of each unit.
These assignments are mostly practical based and should be submitted
in CD or DVD. Theoretical assignments are to be submitted neatly
written on A4 size sheet.
Assignments

All assignments will be submitted to respectivestudycentre of Odisha
State Open University or as directed by Co-ordinator.
All assignment should be unit wise on separate CD/DVDs clearly
mentioning course title and unit on Top. Theoretical Assignment will be
neatly filed or spiral bind with cover clearly mentioning necessary
information of course, student detain on top.

Assessments
There will be “1” assessments for each unit.
All practical assessment will be submitted to OSOU.
Assessments

Assessment will take place once at the end of each unit.
Learner will be allowed to complete the assessment within stipulated
time frame given by the university.
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Video Resources
This study material comes with additional online resources in the form of
videos. As videos puts in human element to e-learning at the same time
demonstrating the concepts visually also improves the overall learning
experience.
Reading

You can download any QR code reader from Google Play to view the
videos embedded in the course or type the URL on a web browser.

7

Getting around this Course material

Working with Digital Images

Getting around this Course material

Margin icons
While working through this Course material you will notice the frequent
use of margin icons. These icons serve to “signpost” a particular piece of
text, a new task or change in activity; they have been included to help
you to find your way around thisCourse material.
A complete icon set is shown below. We suggest that you familiarize
yourself with the icons and their meaning before starting your study.
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Activity

Assessment

Assignment

Case study

Discussion

Group activity

Help

Note it!

Outcomes

Reading

Reflection

Study skills

Summary

Terminology

Time

Tip
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Unit-1
Working with Digital Images
Introduction

involve the integration of liveaction footage and
generated imagery to create
environments which look
Digital images have a “structure”—that is, they are built up from
realistic, but would be
basic elements that are assembled in dangerous,
particular ways
to make up a
expensive,
digital image. The basic unit of a digital
image is
pixel, and
impractical,
or the
impossible
to
these pixels are arranged into arrays
andon those
arrays are
capture
film. Visual
effects
are
processes
arranged into one or more layers. In this unit, we will takeused
a tour
to
manipulate
imagery
of the pixels, arrays, and layers to see how they make up a digital
world which is manipulated
image.
in postproduction house.
This video will provide a brief
overview of this course.

Outcomes

Topic
Upon completion of this unit you will be able to:


Outcomes




YouTube l

Video 1 –Pipeline

https://youtu.be/Q
Understand Digital image, itsMethodology
aspects andinfunctions
Graphics
YIiE
Understand the structureIndustries
of digital images, pixel,
greyscale and colour images
Understand the importance of image resolution
Understand the texture of images
Video 2 –Image Editing

Terminology

https://youtu.be/Sy
4KU

Video 3 –VFX Production

https://youtu.be/29
dz7Y

Designing

Digital image:

A digital image is a numeric representation,
normally binary, of a two-dimensional image.
Depending on whether the image resolution is
Course outcomes
fixed, it may be of vector or raster type.

Pixel:

Pixels are the Digital images that are
bifurcated in to small tiles of separate colours.

Terminology
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Greyscale:

Grey as the name suggests are theimages with
Black and White texture, single channel
images, and one colour(monochrome) images.

Colour images:

These are the form of digital images that are
used to deploy colour to the human eyes.

RGB:

The RGB color model is an additive color
model in which red, green and blue light are
added together in various ways to reproduce a
broad array of colors.

CMYK:

The CMYK color model (process color, four
colors) is a subtractive color model, used in
color printing

Resolution:

The quality of being determined or resolute

Textures:

Theprojection of two-dimensional
images in a three-dimensional object.

Aspect Ratio:

Any images aspect ratio can be referred as the
proportional ratio of its height and width.

digital

Structure of digital images
Digital images maintains a "structure"— that is, they are
developed from fundamental components that are gathered in
specific ways to create a digital image. Pixel is the essential unit of
a digital image, and these pixels are organized into arrays and
further the arrays are organized into one or multiple layers. In the
accompanying, we take a voyage through those pixels, clusters,
and layers to perceive how they together form a digital image.

The Pixel
Pixels are type of the Digital images that are further breached
down in tosmall “tiles” of single colour. * It’s essential for the
computer to have the capacity to get to every one independently
keeping in mind the end goal to control it. Every pixel is likewise
loaded with at least single strong shading or colour. At the point
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when the pixels are sufficiently little they mix together to frame a
smooth picture to the eye, for example, the case of Marcie,
Kodak's well known film young lady found in Figure 1-1.
Notwithstanding, on the off chance that you draw nearer than the
ordinary survey remove, you may begin to see her pixels, as in
Figure 1-2. On the off chance that you get truly close, you can
clearly see her pixels as shown in Figure 1-3.

Fig 1.1 close up
close up

Fig 1.2 Big Close up

Fig 1.3 Extreme

Title-Pixel
AttributionSource- Pexels.com
Link- https://www.pexels.com/photo/close-up-photography-of-womanwearing-red-lipsticks-765193/

Basically Pixels have two important traits fundamental to the
computer.
First To begin with, they are composed in flawless little rows and
columns like a checkerboard, and in the land of computer this is
known as array. After the pixels get organized into an array kin
this manner itsmandatory for the computer to have the capacity
to find them. There are two positions
a) The classic horizontal direction: The horizontal position of a
pixel in an array is referred to as its position in “X”.
b) The classic vertical direction:its vertical position is referred
to as “Y”.
By this way each pixel is provided with aspecific location, or
“address,” in X and Y. or instance, in the event that you had a
picture that was 100 pixels wide and 100 pixels tall, you could
distinguish the correct area of a particular pixel by saying it was 50
columns more than (50 in X) and 10 rows down (10 in Y). In short it
could be said its XY location is 50, 10. This pixel will be different
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from its neighbour that is present, one column to the right at 51,
10, or in the row below at 50, 11. Indeed, every pixel will have a
specific XY location in the image and can be denoted by the
computer, in the same manner, which it is.
The next important trait is that a pixel is having its single colour. As
defined a pixel is all one solitary colour. In a pixel variation of
colour or textures are not permitted. Every pixels colour is
represented by a number. Truth be told, pixels are basically sets of
defined numbers representingcolours that are organized in clear
rows and columns. They are turned in to picture only when the
numbers are converted into colours by a display device like TV set
or computer monitor.
*The word Pixel is gotten from "pix" a slang truncation for
"pictures", and "el" originates from "component", so the pixel
signifies "picture component".

Greyscale Images
Black and white images, one channel images, and monochrome
(one color) images are the other names of Greyscale Images. The
assortment of names is because of the way that few diverse
technical disciplines have built up their own terms to depict a
similar thing.Historically it emerges from many discipline so
thisoccurs frequently in computer graphics. Herewe shall call them
asgreyscale images for better clarification and brevity. Due to their
simple attribute Greyscale images are used commonly in
computer graphics, they are a perfectmethod to effortlessly
approach the subject of digital images. They exhibit just a single
channel, or layer, whereascolor images have three channels or
more, which we shall come across shortly.
Digitization of a black and white picture can be one case of a
greyscale image is, and the next more pertaining caseare the
majority of the mattes on the planetMattes may be utilized to
compose one picture above the other.The latter cases are outlined
in Figure 1-4. These pictures don’t have any colour as they are
greyscale images. Even though differences in appearance of the
two images the common is that both of them are one-channel
images. Here one channel, orlayer, implies that the
imagescomprised of only one array of pixels with the values of
brightness ranges from black to white and shades of grey.
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Greyscale image
pixels

Close up pixels

Matte

Close up

Fig 1.4 Examples of greyscale images and their pixels

Fig 1.5 An array of pixels

When we see this one channel array of pixel it can be
interpreted as close and personal, Figure 1-5 zooms in to a tiny
little region of pixels in the greyscale image of Figure 1-4. The
numbers in Figure 1-5 are the code values of each pixel. These can
be refered as code values on the grounds that encoding or
measuring the numerical values, the splendor of every pixel. The
dim chip that each numerical values encode, or quantify, the
brightness of each pixel. The grey chip that each code value sits on
speaks to how brilliant that pixel will show up when shown on a
screen.Internally the computer utilizes the code values that are
arranged in to an arrayfor representation of the picture. The
important thing here to focus is thatjust one array of code values
exists, which is known as a channel, and the code values are
concerned only with brightness, and not colour.
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Color Images
In the actual world our eyes can see the entire spectrum or range
of colour however in reality our eyes, aresensitizefor three
colorsof light that is red, green, and blue. Since our brain "blends"
segments of these three hues we could see other colours like
yellow, magenta, and cyan. Take an example, red and green are
blended to get yellow. A similar trap is utilized as a part of the
majority of our picture are displayed in devices such as television,
led panel displays, digital projectors, and feature film. Actually all
these gadgets projects only red, green and blue colours that is
coordinated in our brain and integrated as each and every colour
shades of the rainbow. To make a colour display device for
humans, all you need is red, green, and blue, which is abbreviated
RGB.

RGB Image

Red Channel

Green Channel

Blue Channel

Fig 1.6 A RBG image is made of up 3 channels

Until and unless the digital images have RGB data on them the
human eyes could not see the colours of digital images displayed
over the screen. In the past segment, we came across about the
working of the greyscale images, the way it uses its solitary single
channel and since it’s been made from the arrangement of
numbers in single array that inturn represents the brightness
values of the pixel from black to white.
By and large now we will be using three channels and now we can
assign one of these colours to each channel, say one to red, other
to green and last to blue. Now we can put distinct code values in
these three channels of each pixel which in turn is going to enable
us to allocate a specific RGB code value to every pixel. This scheme
will allow us to assign a unique RGB code value to each pixel in our
colour image by putting different code values in the red, green,
and blue channels of each colour pixel. We now have a colour
image composed of three channels, which is referred to as an RGB
image, as illustrated in Figure 1-6. Note how the yellow paint cans
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in the RGB image appear bright in the red channel, medium in the
green channel, and dark in the blue channel. Having these
different values in each channel is what gives the image its
colours.
Even though in the RGB image every channels data represents
different values of red, green or blue colour pixel per pixel but if
we see the data the data is in different hues of grey. This is
because of the reason that the different shades of grey depicts the
amount of brightness of that particular channel of every pixel.You
could observe this in the Figure 1-7:

Fig 1.7 Grey RGB data becomes colour

If we see the extreme left you could see the red pixel, containing
the red chip coded as “R” appears to be very bright whereas the
Green and Blue pixel consisting of green and blue chips, coded as
Suppose there is plenty of red and minute amount of green and
blue that indicates the colour is red. next to the red we have
yellow pixel that has bright R and G values above it, but a low
(dark) B value, which is the quintessential definition of yellow. The
skin tone chip shows a more typical RGB combination to make a
common skin tone color. Lastly the grey pixel demonstrates a
unique case. In the event that every one of the three of the RGB
esteems are the same, than grey color is produced. Indeed, this
defines grey that every one of the three channels having parallel
estimations of brightness. At the point when the RGB estimations
of a pixel happens to be unique in relation to each other, this
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forms hues or colour.

Fig 1.8 Grey RGB data gets it colour from the display device

In an event that the RGB information is entirely grey or in black
and white,than from where the the colours are visible in a
coloured image? The answer is the generation of the colour is
originated from display like digital projector, TV, LED screen, etc.
As shown in Figure 1-8. For instance in a digital projector for the
red channel the grey data is feeded to the red lamp of a digital
projector as a result of which the whole screen is filled with
adequate amount of red light at every pixel. Same way The green
and blue data go to their respective lamps. after this all the images
of red ,blue and green superimpose on each other that makes the
eyes to see the colour. Important aspect here is to be noted
basically a colour image is a three channel image where in each
channel it consists of distinct RGB data in every channel The key
point to note from this is a shading picture is a three-channel
picture that contains isolate RGB information into each channel,
but the data in these channels is, indeed grey.
Adobe Photoshop will conveniently outlinenow. To visualise the
effect upload acolor photographic kind picture into Photoshop
(not a convenient graphic). Select the Channels palette (it should
be notedin the Photoshop software also they are called as
channels), at that point close up the visibility (the eyeball icon) for
every channel with the exception of the Red channel. You ought to
be watching a
gray image. Currentlyclick
on
the inexperienced channel
and
view
the
other, however completely different, grey image. Attempt the
Blue
channel.
It’s completely
different another
time. It’s vital to consider RGB pictures as 3 channels
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of grey data just since that's however thePC thinks of them. To
master
digital
compositing, you
would
like to
understandhowever the PC assumes therefore you'll think over it.

Four-Channel Images
A three-channel RGB image will be made as a four-channel image
if a
matte is enclosed within it that's placed in an exceedingly fourth
channel.This newly formed four-channel image is named as alpha
channel that is denoted by letter “A, “and then onward this fourchannel image is named as a RGBA image.
A three-channel RGB image can have a matte included with it that
is placed in a fourth channel, making it a four-channel image. This
fourth channel is called the alpha channel, which is represented by
the letter “A,” so a four-channel image is referred to as a RGBA
image. CGI is a case of an RGBA image ,it is displayed in Figure 1-9.
Likewise its totally conceivable to have pictures with more than
four channels, yet you will plausible experience them later in your
profession..

Fig 1.9 A four channel RGBA image

Attributes of digital images
Now that we have already discussed about the digital images
models or structures, additionally we couldinvestigate the
different characteristics of digital images. Not only they appear in
different shapes and sizes but also,in the internal representation
of the image and data variations exists.So this segment will
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basically begin with digitizing an image in order to know about
it.After that we shall know in length about the distinction
between display aspect ratio image aspect ratio, and pixel aspect
ratio—3 extremely confusing ideas. This will elaborate all the
essential points and clarify all doubts.

Digitizing Images
Despite the fact that they play out a tremendous assortment of
capacities, by the day's end, whatever they can do is control
numbers (in addition to a little Boolean logic en route). Thus, they
take a shot at must be changed over to numbers or whatever we
load or feed in is lessened to numbers.Even if to create a text file
such as an text message, email, a book or a word processor
document each letter of the alphabet is assigned with a defined
number. The audio files after conversion to numbers to create
MP3 files only could be played or listened over DVDs, iPods, , and
other MP3-enabled devices. In addition, the photos must be
changed over to numbers before the PC can work with them. On
the off chance that it isn't first changed over to numbers, the PC
basically can't manage it.
When a picture or an audio say a sound track is converted in to
numbers or digits the phenomenon known as digitizing. After
completion of the digitization of the image, aPC after having the
digitized image, any work becomes possible. The two important
concept that should be clear on digitizing images are:



The first is how the entire process is done.
The second are what issues occurred during the process
and how to resolve them.

Following example will explain both points on analysis of the
digitized image.

Fig 1.10 Original Picture
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Fig 1.11 Sampling points
picture

Fig 1.12 Digitized
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Image Resolution
Dot per pixel or DPI is thought as resolution. Image resolution
refers to how {many|whatpercentage|what number} pixels wide
and the way many pixels tall image is. Let’s say, if a picture were
three hundred pixels wide and three hundred pixels tall, the image
resolution would be 300 by 300, or written as 300 × 300. The PAL
video image features a resolution of 720 × 576 component. A
regular academy aperture feature frame has a picture resolution
of 1828 × 1332. The pictures from a photographic camera might
need a picture resolution of 3072 × 2048 or additional.
Notice that nothing was mentioned about the “size” of the image.
This is on account of the real display size of a picture changes
relying upon the display device it is seen on. The display size can
vary, but the NTSC and PAL image resolution remains the same i.e.
720 × 486 & 720 × 576 respectively. Say the projection of a small
movie or a feature film,can be done on a small screen in a small
theatre, or on a huge screen in a large auditorium. Here again the
difference is in display size, but in case of a 35 mm film image
resolution remains intact and same. We do need to be cautious
here in light of the fact that the termresolutionhas an altogether
different meaning in other disciplines. The typical significance for
the word outside of digital compositing isn't what number of
pixels are there in the whole picture, yet what number of pixels
are there in per unit of display—that is, what number of pixels per
inch or dots per centimetre.

Image Aspect Ratio
The aspect ratio of an image is defined by the aspect ratio of a
picture is really a portrayal not of its size or its resolution, but
rather of its shape. It depicts whether the picture is tall, thin, or
low and wide. Each picture on your PC will have a built up aspect
proportion, and image resolution, and all your work must comply
with it. The aspect ratio is essentially the proportion of the
picture's width to its tallness, so it is computed by partitioning the
picture's width by its height. For example, if the image resolution
is 400 × 300, divide 400 by 300 the aspect ratio thus obtained will
be 1.33, the classic video resolution. It should be noted that the
image aspect ratio can be applied on image file, but by this it could
not be predicted that how it’s going to look on the final display.
There are instances that thethe image aspect ratio and its display
aspect ratio may differ. We will discuss this in coming topics.

19

Unit-1 Working with Digital Images

Pixel Aspect Ratio
As we know that the digital images contains pixel.as in images the
pixels have a defined shape which is again denoted by its imageaspect ratio. You should make a point that all pixels are not
equal.Like in a square pixel, same as a square image, shall have a
pixel aspect ratio of 1.0, however there are lot of display systems
that don’t have square pixels. Figure 1-13 shows the non-square
pixel aspect ratios you may commonly come across in production.

Fig 1-13 Common pixel aspect ratios

Explanation of the above figure:
The left example shows an NTSC (American television) video pixel
that has a pixel aspect ratio of 0.9, making it tall and thin.
The middle image describes a PAL (European television) video
pixel that has a pixel aspect ratio of 1.1, that makes it short and
wide.
Generally square pixels are found in many feature film format,but
the Cinema Scope (Cscope) format is a specific widescreen format
that has a pixel aspect ratio of 2.0, making its pixels too wide.
Luckily, video formats of all HDTV (High Definition Television)
consists of square pixels.

Display Aspect Ratio
So by this time it’s been clear that the image aspect ratio depicts
the images shape and the pixel aspect ratio depicts the pixels
shape. And these two factors integrate and referred as the display
aspect ratio i.e. the images shape after being projected through a
display device. The significance of the Display aspect ratio is that,
there may be variance in the aspect ratio of the image and the
display device on which the image is displayed. This variation is
caused because of the pixel aspect ratio. If the pixels are square,
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then the image aspect ratio and the display aspect ratio are
identical.
Texture
When two-dimensional color pictures are projected in threedimensional object it is known as texture. A 3D model of the scene
can be constructed from a single image, without knowing the
layout of common surfaces of the scene, as done in previous
works. The understanding of texture of objects improves object
detection.
Scene interpretation is a long-standing, basic problem in computer
vision. Recent work demonstrates that a synergistic treatment of
diverse image-understanding tasks, including object recognition,
image segmentation, and 3D-scene reconstruction, may overcome
many errors induced by addressing them in isolation. These
approaches typically fuse object detections with supervised priors
of spatial layouts of common scene surfaces (e.g., the sky is on the
top, and the ground is planar and horizontal).
While holistic scene interpretation shows great promise, the
treatment of the 3D scene layout in existing work has certain
shortcomings. First, they make the restrictive assumption that
surfaces in the scene are planar, and discredited surface
orientations into a pre-specified number of classes (e.g., buildings
may face only left, right, or front). Second, they typically estimate
surface orientation classes too locally (e.g., per each super pixel),
without accounting for the long-rage spatial relations among
image parts. This may easily lead to implausible 3D layouts.
One visual cue that has been overlooked, and that could address
the aforementioned shortcomings of prior work, is texture arising
from a spatial repetition of objects in the scene. In general,
textures of recurring objects are ubiquitous. For example,
windows on a building facade jointly give the percept of window
texture, and a sequence of cars parked along a street gives rise to
car texture, as illustrated in Fig 1. In a cafeteria scene, tables and
chairs, and people standing in a line comprise many distinct
textures. Also, in natural scenes, one can easily find textures
corresponding to flocks of birds, herds of animals, or tree lines.
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Summary

Summary

This unit gave an introduction to the basics of digital images. It
elaborated the structure of digital images and other key elements
like pixels, greyscale images, colored images, RGB and four scale
images. It also discussed the various attributes of the digital
images like, digitizing images, image resolution, image aspect ratio
display aspect ratio and the basics of image texture.

Assessments
1. What are pixels?
2. RGB is made of how many channels? Mention them.
Assessment

3. What is image aspect ratio?
4. What is picture aspect ratio?
5. What is display aspect ratio?

Resources

Reading
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1. Wright, Steve. Compositing visual effects: Essentials for the
aspiring artist. Taylor & Francis, 2011.
2. Payet, Nadia, and SinisaTodorovic. "Scene shape from texture
of objects." Computer Vision and Pattern Recognition (CVPR),
2011 IEEE Conference on. IEEE, 2011.
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Unit 2
Managing file formats for
Images
Introduction
We come across lot of images and each image is either shared or
received by usor deliver to a client or colleague. These imagesare
present in the form of a file, and files are available in a massive
form of completely different formats. It’s a true facility in front of
you, where you have to apply your wisdom while choosing the file
formats. We should be cautious about the selection because of
the following reasons:
Firstly because if you send a file or receive a file from someone in
a specific format that the software or programme could not read,
you will be lost and end your start there itself.
Secondly if you choose the file formats via which your image file
get compressed than the image quality may be compromised or
degraded. Sometimes your selection may work and sometimes it
may not work.
Thirdly, if you pick a wrong file format the file size may increase,
more than your requirement. Many peopledon’t want to
unnecessary waste their disk space, download time, network
bandwidth, and production time.

Outcomes
Upon completion of this unit you will be able to:



Outcomes



Understand the basics of image file formats
Understand the basics of file compression
Realize the importance of Dots per inch in digital images
Know the basics of EXR
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Terminology
File:

A computer file is a computer resource for
recording data discretely
in
a computer
storage device. Just as words can be written
to paper, so can information be written to a
computer file?

File Format:

A file
format is
a standard way
that
information is encoded forstorage in
a computer file.

Graphics:

Graphics are simple images created or drawn
with designing software’s.

Photographic
images:

These are real scenes captured by some kind
of camera, either digital or film.

Terminology

EXR:

It is a floating-point image file format
developed by Industrial Light & Magic (ILM).
JPEG:

JPEG or Joint Photographic Experts Group is
an older lossy compression file
format
specifically designed for photographic images.

Compression:

It reduces the size of the file so that it can be
shared conveniently.

DPI:

DPI is used to describe the resolution number
of dots per inch in a digital print

Image file formats
Before taking a gander at the file formats, there are a couple of key ideas to
think about certain picture writes and pressure plans. In this segment, we will
investigate the contrasts between photographic pictures and designs on the
grounds that the kind of picture you have powerfully influences the decision
of the pressure plot. The EXR file formats gets its own particular extraordinary
say due to its rising significance in the visual impacts industry.
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Photographic Images vs. Graphics
There are extremely two noteworthy kinds of images: Photographic
images and graphic images. Photographic images are genuine scenes
caught by some sort of camera, either digital or film. Their key element
is that their pixel esteems fluctuate significantly everywhere throughout
the picture, in this way making them "complex." Graphics, then again,
are straightforward images made or drawn with designing
programming's, for example, Adobe Photoshop, Adobe Illustrator, Coral
Draw, indesign, and so forth. The key component is that their pixel
esteems don't fluctuate more over the image.

Fig 2.1 Pictures and graphics have very different pixels variations

Figure 2.1 shows this significant distinction between the two kinds
of pictures at the pixel level. In the nearby of photo, no two pixels
are of a similar shading(colour). In the graphic close-up there are
substantial regions of indistinguishable pixel esteems. These
distinctions are utilized while choosing a compression scheme. A
lossless sort of compression would be utilized on the realistic in
light of the fact that the document size could be packed by
exploiting every one of the pixels of a similar esteem. Such a plan
would be futile on the photo and result in for all intents and
purposes no document size lessening. A lossy pressure plan would
detectably harm the graphic, yet can go unnoticed in the photo if
not squeezed too far. Indexed Color Images (CLUT)

Fig 2.2 an indexed color image

The document size of any RGB image can be extensively
diminished by changing over it to an ordered shading image. The
PC initially completes a factual examination of all the RGB hues in
the image and afterward delivers a Look-Up Table (LUT) of just 256
hues, which speak to the nearest 256 midpoints of the
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considerable number of hues in the RGB image. It at that point
makes a one-channel 8-bit "index" image where every pixel is
extremely a pointer or index to one of the hues in the
shading(colour) table. To show the image in colour the PC takes a
gander at every pixel in the index image, takes after that file to its
shading chip in the LUT, understands that RGB esteem, and shows
it on the screen as the red arrows appear in Figure 2.2
Despite the fact that the scope of hues is genuinely lessened (256
hues rather than 16 million), the subsequent colours image looks
shockingly great (in the event that you don't look too carefully).
The Marcie colours image in Figure 2-2 is a genuine index colours
image. this is because the look is so great is that the 256 hues in
the LUT are full 24-bit RGB esteems. Since there are just 256 of
them, they don't expand the file size extensively. A typical
shortening for index colours images is CLUT, that represents Color
Look up Table.
CLUT images work exceptionally well for graphics, particularly if
the graphics has under 256 hues in it. The CLUT form would then
be a lossless pressure. Photographic images can be changed over
to a CLUT, obviously, yet they get severely pounded all the while
during the process. it might be OK for a website, however not for
printing a 8 × 10 portrait.

Compression
All file formats offer some sort of data compression feature. A few
sorts of data compression are lossless, implying that as soon as the
compressed file is opened, the image is a correct imitation of the
first. Be that as it may, some compression schemes are lossy,
implying that the compressed image has endured a few
misfortunes, or corruption.
Two transcendent lossless compression plans are RLE and LZW.
Run Length Encoding (RLE), which is quite often utilized for
rendering CGI pictures; and, Lempel-Ziv-Welch (LZW), that is
essential since it is accessible in a considerable number image file
formats. Since these are lossless compression plans, they lessen
file measure with no debasement of the image; moreover, they
can likewise be utilized together. Utilize them unreservedly on CGI
and graphics realizing that they won't hurt your photos.
Photographic pictures can utilize LZW, however there will be
negligible compression.
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Two transcendent lossy compression plans are JPEG and MPEG-2.
The JPEG compression is proposed for still photographic pictures
and fundamentally evacuates fine detail in the picture to lessen its
file size. It debases the picture quality, and if set too high can
corrupt it genuinely. The MPEG-2 compression is particularly
intended for moving pictures, for example, video. It begins by
playing out a JPEG-type compression on chosen key frames, and
after that it shrinks the middle frames by developing a rundown of
distinctions between the key frames.

EXR
Open EXR, or EXR, is a drifting point image file format created by
Industrial Light and Magic (ILM) that is quick turning into an
industry standard. It’s likely that you may experience it right off
the bat in your digital compositing vocation and more probable
after some time, so how about we investigate it intently. The
following area discusses the different essential image file formats,
however EXR is both remarkable and sufficiently vital to get its
own spot in the sun, particularly in light of the fact that it was
particularly created in viewing the compositors. Here is an outline
of its primary highlights:
• High powerful range: - Designed particularly to oblige high
unique range image data, for example, film checks and
photorealistic CGI components. The dynamic range (darkest to
brightest) of a normal screen may be around 150 to one and
projected film maybe 2000 to one, whereas EXR's dynamic range
is over a billion to one!
• Many channels: - when the basic CGI render is a four-channel
image, EXR is expandable to any number of channels. The reason
for existing is to abstain from rendering the many obstacles or
passes of a CGI subject into multiple separate files. They would all
be able to be in their own channels inside one EXR file.
• Lossless compression: - Designed for including feature film work,
film outlines are extensive photographic images that take up a
considerable disk space and network or system exchange time. A
special lossless compression plot is bolstered that slices file sizes
down the middle with no corruption to the image and it is quick to
compress and uncompress.
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• Short float: - A floating point format, however rather than the
standard 32-bit drift, actualizes a novel 16-bit "short buoy." This
understands the speed punishment as a rule related with floating
point, while keeping up all that could possibly be needed
exactness notwithstanding for include film work. At the end of the
day, it gives a speed of number with the exactness of float.
Open EXR was discharged by ILM to the world as an open standard
for nothing in 2003 keeping in mind the end goal to quickly spread
it into the visual impacts industry. It has worked. Many 3D
animation and compositing programs now bolster EXR. It has even
entered to the omnipresent programming resembles Adobe After
Effects and Adobe Photoshop.

File Formats
We can't talk about each file format in the entire library as that
would be a whole epic book. Rather this topic comprise of a
leniently concise portrayal of a few of the most widely recognized
and imperative file formats we go over regularly being a
compositor.
As we are well aware that in order to recognize an image we need
to add extension to the file name to know what is the format that
the file belongs to. In the event that the file is in TIFF format, for
instance, the file name will appear as "filename.tif," a JPEG picture
would be named "filename.jpg," et cetera. In view of this, the file
formats are recorded beneath in sequential order arrange in view
of their filename expansions.
• .bmp: An adaptable Microsoft Windows image file format that
backs the two photos and graphics. These images are saved as 8 or
16 bits, BW, RGB, RGBA, and CLUT. No compression.
• .cin: Cineon is a more seasoned, extremely particular file format
particularly for 10-bit log film scans. No compression, no choices,
and nothing specific. It underpins BW, RGB, and RGBA pictures.
• .dpx: Digital Picture Exchange, a newly introduced file format for
10-bit log film scans that is supplanting the Cineon format. Assists
numerous channels, linear and log data, and multiple bit depths.
sometimes HDTV video frames are saved in the .dpx format.
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• .exr: Short form of Open EXR, Industrial Light and Magic's (ILM)
broadened extensive range file format basically designed to work
for images of feature film. It highlights floating point information
and the colossal vibrant scope of hue and bright required for topquality element film work.
• .gif: Most generally observed as a 8-bit CLUT file format basically
used for graphics that is broadly utilized for the web. Incorporates
assist for animation in a single file and doles out one CLUT hue for
hard-edged transparency. It additionally assists 8-and 16-bit
images, BW, RGB with lossless compression, yet no one appears to
mind.
• .jpg: JPEG, or Joint Photographic Experts Group, is a more
established lossy compression file format particularly intended for
photographic images. The fundamental component is the capacity
to dial in the measure of compression to influence the file to
estimate smaller, which likewise influences how much image data
is lost. Unreasonable compression causes genuine loss of image
quality and presents antiquities or artifacts.
• .jp2: JPEG 2000, a more up to date lossy compression file format,
which is additionally particularly intended for photographic
images. In view of a totally unexpected innovation in comparison
to JPEG, it compresses image files to a littler size while presenting
less rarities or artifacts.
• .mov: Apple's pervasive QuickTime motion image file format is
utilized to store moving images. The QuickTime file format is really
a "wrapper" that assists a not insignificant rundown of conceivable
compression plans called codecs (Coder/Decoder). While
numerous projects can read QuickTime films, inconvenience
comes when the motion picture (movie) is packed with a codec
that the program endeavoring to peruse or read the file doesn't
have.
• .png: The Microsoft Windows variant of a .gif file that assists
genuine transparency.
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• .psd: Adobe Photoshop file format that assists isolate layers for
the different components of a image. Expected for Photoshop
image altering, it isn't assisted by numerous different projects.
• .tga: Targa, a Microsoft Windows-based file format that assists
CLUT, BW, RGB, RGBA, 8 bits for each channel, and lossless
compression.
• .tiff: - TIFF, the most vital image file format in light of the fact
that it is assisted by for all intents and purposes each digital
imaging program in the whole world. It is a to a great degree
adaptable and completely attributed file format that assists
various channels, 8-and 16-bit images, and lossless compression.
Perfect for CLUT, BW, RGB, RGBA, illustrations, photos, CGI, and
practically every other image write aside from a compacted photo
(utilize JPEG or JPEG 2000).
• .yuv:- A file format particularly for video frames. Numerous
projects can read .yuv files and change over them to RGB for show
on the screen, and the resulted outcome will be a .yuv file.

Dots per inch (dpi)
The idea of dpi is utilized as a part of print media for books and
magazines and so forth. It is vital to talk about dpi, or "dabs per
inch," while examining computerized images is basically on
thegrounds that it is a consistent wellspring of perplexity and
confusion in visual impacts. Dpi is likewise appeared in Adobe
Photoshop in the Image Size dialogue box as “Resolution.” with
regards to printing, resolution implies what number of pixels are
printed per inch of paper. With regards to advanced compositing,
determination implies the width and tallness of a image in pixels.
In the event that you have a image that is 100 pixels wide and it
will be imprinted in a magazine as a 1-inch wide image, you would
clearly have 100 pixels spread crosswise over one inch of paper. In
this way, the photo would have a print determination of 100 pixels
for each inch. For respecting print custom, it would really be
alluded to as 100 dpi (dabs per inch). Presently assume you have a
500-pixel image and its print will be a five inch image. The
resolution would even now be 100 dpi in light of the fact that in
one inch of image despite everything you have 100 pixels. Don't
bother the way that the photo is five inches wide. In any case,
assume your 500-pixel image was printed as a one inch image. You
would now have a 500 dpi image since 500 pixels are spread more
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than one inch. For a given image width in pixels, the littler it is
printed, the more pixels per inch, the more prominent the dpi. For
a settled image measure, the higher the dpi the more honed the
image will be. ( see Figure 2-3)

30dpi

75dpi

300dpi

Fig 2.3 Increasing the dpi makes the picture sharper

One can really watch this in real life in Photoshop. Upload a image, and
after that go to the "Image Size" dialogue box. To start with, uncheck
"Resample Image" present in the bottom side. Now its going to advice
Photoshop to not to change the image "Pixel Dimensions: Width or
Height" (what we computerized typesetters call image resolution).
Presently go to the "Resolution" window and there you enter or change a
number and note that the values change the “Document Size: Width
and Height”. Next change the values of "Width or Height" and observe
the change in the "Resolution “value. What exactly the phenomenon is
that the image width and height were locked with the goal that the real
pixel counts will not get altered while adjusting the dpi to perceive how
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the subsequent image will be printed bigger or littler on paper.
This story has two focuses. The primary point is that if an image is made
in Photoshop for a visual impact shot, the question may arise that what
the dpi should be. The appropriate response should be dpi is unessential.
By this it clarifies that the Width and Height of the image in pixels that
are imperative to us. This will jumble some Photoshop specialists whose
orientation is more towards printing. Secondary point is that when images
are produced from a visual results shot to Photoshop or to print, (for
example, PR photographs), this may likewise bring up the issue of the
dpi. A casing of film or video from a visual impacts shot has no natural
dpi. Which consists of just Width and Height in pixels. But at the time of
printing it should be allotted a dpi to set how lengthy the image will be
printed. The dpi value and image printing is complementary to each
other. The higher the dpi is set the littler the image will print. For
instance, if a 600 × 300 image was relegated a dpi of 300 the printout will
be 2 inches wide. Be that as it may, on the off chance that it is set at 600
dpi the print will be in one inch of paper.

Unit Summary

Summary

This unit gave detailed knowledge regarding the Managing File
formats for images, import and export techniques. It elaborated
the basics of file formats and dots per inch importance in digital
images. Also discussed about the photographic images vs
Graphics, indexed colour images, EXR; the industry standard and
the basics of EXR. It also explained the importance of compression
in digital images.

Assessment

Assessment
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1.
2.
3.
4.
5.
6.

What are indexed colour images?
What is the importance of EXR?
What are the various digital image file formats?
What is DOT and discuss its importance in digital image?
What is DPI?
True or False
a. Increasing the DPI makes the image less sharp
b. GIF is a video format

Digital Imaging

7. What is full form of the commonly used JPEG format?

Resources
1. Wright, Steve. Compositing visual effects: Essentials for the
aspiring artist. Taylor & Francis, 2011.
2. https://en.wikipedia.org/wiki/Image_file_formats
Resources
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Unit 3
Image Editing with GIMP
Introduction
Gimp is an acronym for GNU Image Manipulation Program. Gimp
is a freely distributed piece of software suitable for such tasks as
photo retouching, image composition and image authoring. It is an
extremely capable piece of software with many capabilities. It can
be used as a simple paint program, an expert quality photo
retouching program, an online batch processing system, a mass
production image renderer, an image format converter and more.
Gimp is expandable and extensible. It is designed to be augmented
with plug-ins and extensions to do just about anything. The
advanced scripting interface allows everything to be easily
scripted, from the simplest task to the most complex image
manipulation procedures.
This unit will elaborate the various applications of Gimp and
demonstrate the step by step process of editing photographs
utilizing it.

Outcomes
Upon completion of this unit you will be able to:

Outcomes
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Edit photographs using the advance techniques layer like
blend and the exposure tools of the Gimp.



Blend two different exposures of the same scene combined
to get the best parts of both images.
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Terminology
GIMP:

GIMP ( /ɡɪmp/ GHIMP)
(GNU
Image
Manipulation Program) is a free and opensource raster graphics editor used for
image retouching and editing,
freeform drawing,
converting
between
different image formats, and more specialized
tasks.

Masking:

Layer masks are a fundamental tool in image
manipulations. They allow you to selectively
modify the opacity (transparency) of the layer
they belong to. This differs from the use of
the layer Opacity slider as a mask has the
ability to selectively modify the opacity of
different areas across a single layer.

Quick Mask:

The Quick Mask allows you to paint a
selection instead of just tracing its outline.

Layers:

A GIMP image is as a stack of transparencies:
in GIMP terminology, each individual
transparency is called a layer.

Terminology

What is GIMP?
Gimp is an acronym for GNU Image Manipulation Program. Gimp
is a freely distributed piece of software suitable for such tasks as
photo retouching, image composition and image authoring. It is an
extremely capable piece of software with many capabilities. It can
be used as a simple paint program, an expert quality photo
retouching program, an online batch processing system, a mass
production image renderer, an image format converter and more.
Gimp is expandable and extensible. It is designed to be augmented
with plug-ins and extensions to do just about anything. The
advanced scripting interface allows everything to be easily
scripted, from the simplest task to the most complex image
manipulation procedures.
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Features and capabilities
A brief list of Gimp features:














Full suite of painting tools including brushes, a pencil, an
airbrush, cloning, etc.
Tile-based memory management so image size is limited
only by available disk space.
Sub-pixel sampling for all paint tools for high-quality antialiasing.
Full Alpha channel support.
Layers and channels.
A procedural database for calling internal Gimp functions
from external programs, such as Script-Fu.
Advanced scripting capabilities.
Multiple undo/redo (limited only by disk space).
Transformation tools including rotate, scale, shear and flip.
File formats supported include GIF, JPEG, PNG, XPM, TIFF,
TGA, MPEG, PS, PDF, PCX, BMP and many others.
Load, display, convert and save to many file formats.
Selection tools including rectangle, ellipse, free, fuzzy,
bezier and intelligent.
Plug-ins that allow for the easy addition of new file formats
and new effect filters

Basic GIMP Concepts
This section is intended to give you a brief introduction to the
basic concepts and terminology you will need to understand in
order to use Gimp.

Working with Images
Image types It is tempting to think of an image as something that
corresponds with a single display window, or to a single file such
as a JPEG file, but really a Gimp image is a rather complicated
structure, containing a stack of layers plus several other types of
objects: a selection mask, a set of channels, a set of paths, an
"undo" history, etc. The most basic property of an image is its
mode. There are three possible modes: RGB, greyscale, and
indexed.
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Quick Mask

Screenshot

The selection tools sometimes show their limits when they have to
be used for creating a complex selection. In these cases, using the
Quick Mask can make things much easier. Simply put, the Quick
Mask allows you to paint a selection instead of just tracing its
outline.

Layers
A good way to visualize a GIMP image is as a stack of
transparencies: in GIMP terminology, each individual transparency
is called a layer. There is no limit, in principle, to the number of
layers an image can have: only the amount of memory available
on the system. It is not uncommon for advanced users to work
with images containing dozens of layers.
The organization of layers in an image is shown by the Layers
dialog, which is the second most important type of dialog window
in GIMP, after the Main Toolbox. The appearance of the Layers
dialog is shown in the adjoining illustration. How it works is
described in detail in the Layers Dialog section, but we will touch
on some aspects of it here, in relation to the layer properties that
they display.
Each open image has at any time a single active drawable. A
"drawable" is a GIMP concept that includes layers, but also several
other types of things, such as channels, layer masks, and the
selection mask. (Basically, a "drawable" is anything that can be
drawn on with painting tools.) If a layer is currently active, it is
shown highlighted in the Layers dialog, and its name is shown in
the status area of the image window. If not, you can activate it by
clicking on it. If none of the layers are highlighted, it means the
active drawable is something other than a layer. In the menu bar
37

Unit 3 Image Editing with GIMP

above an image window, you can find a menu called Layer,
containing a number of commands that affect the active layer of
the image. The same menu can be accessed by right-clicking in the
Layers dialog.

Undoing
Almost anything you do to an image in GIMP can be undone. You
can undo the most recent action by choosing Edit Undo from the
image menu, but this is done so frequently that you really should
memorize the keyboard shortcut, Ctrl Z.
Undoing can itself be undone. After having undone an action, you
can redo it by choosing Edit Redo from the image menu, or use the
keyboard shortcut, Ctrl Y. It is often helpful to judge the effect of
an action by repeatedly undoing and redoing it. This is usually very
quick, and does not consume any extra resources or alter the undo
history, so there is never any harm in it.
If you undo one or more actions and then operate on the image in
any way except by using Undo or Redo, it will no longer be
possible to redo those actions: they are lost forever. The solution
to this, if it creates a problem for you, is to duplicate the image
and then operate on the copy. ( Not the original, because the
undo/redo history is not copied when you duplicate an image.)

Grids and Guides
You will probably have it happen many times that you need to
place something in an image very precisely, and find that it is not
easy to do using a mouse. Often you can get better results by
using the arrow keys on the keyboard (which move the affected
object one pixel at a time, or 25 pixels if you hold down the Shift
key), but GIMP also provides you with two other aids to make
positioning easier: grids and guides.

Image Grid

Screens
hot
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Each image has a grid. It is always present, but by default it is not
visible until you activate it by toggling View Show Grid in the
image menu. If you want grids to be present more often than not,
you can change the default behaviour by checking "Show grid" in
the Image Window Appearance page of the Preferences dialog.
(Note that there are separate settings for Normal Mode and
Fullscreen Mode.)

Guides

Screenshot

In addition to the image grid, GIMP also gives you a more flexible
type of positioning aid: guides. These are horizontal or vertical
lines that you create by clicking on one of the rulers and dragging
into the image. You can create as many guides as you like,
positioned whereever you like. To move a guide after you have
created it, activate the Move tool in the Toolbox (or press the M
key), you can then click and drag a guide.
To delete a guide, simply drag it outside the image. Holding down
the Shift key, you can move everything but a guide, using the
guides as an effective alignment aid. As with the grid, you can
cause the pointer to snap to nearby guides, by toggling View Snap
to Guides in the image menu. If you have a number of guides and
they are making it difficult for you to judge the image properly,
you can hide them by toggling View Show Guides. It is suggested
that you only do this momentarily; otherwise you may get
confused the next time you try to create a guide and don't see
anything happening.

Paths
A path is a one-dimensional curve.
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Screenshot

Paths are used for two main purposes:



A closed path can be converted into a selection.
An open or closed path can be stroked, that is, painted on
the image, in a variety of ways.

Paths can be created and manipulated using the Path tool. Paths,
like layers and channels, are components of an image. When an
image is saved in GIMP's native XCF file format, any paths it has
are saved along with it. The list of paths in an image can be viewed
and operated on using the Paths dialog. If you want to move a
path from one image to another, you can do so by copying and
pasting using the popup menu in the Paths dialog, or by dragging
an icon from the Paths dialog into the destination image's window.

Brushes

Screenshot

A brush is a
set
of
used
for
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GIMP includes a set of 10 "paint tools", which not only perform
operations that you would think of as painting, but also operations
such as erasing, copying, smudging, lightening or darkening, etc.
All of the paint tools, except the ink tool, use the same set of
brushes. The brush pixmaps represent the marks that are made by
single "touches" of the brush to the image.
A brush stroke, usually made by moving the pointer across the
image with the mouse button held down, produces a series of
marks spaced along the trajectory, in a way specified by the
characteristics of the brush and the paint tool being used. Brushes
can be selected by clicking on an icon in the Brushes dialog.
GIMP's current brush is shown in the Brush/Pattern/Gradient area
of the Toolbox. Clicking on the brush symbol there is one way of
activating the Brushes dialog.

Gradient
A gradient is a set of colors arranged in a linear order. The most
basic use of gradients is by the Blend tool, sometimes known as
the "gradient tool" or "gradient fill tool": it works by filling the
selection with colors from a gradient. You have many options to
choose from for controlling the way the gradient colors are
arranged within the selection. There are also other important
ways to use gradients.

Screenshot

When you install GIMP, it comes presupplied with a large number
of interesting gradients, and you can add new ones that you
create or download from other sources. You can access the full set
of available gradients using the Gradients dialog, a dockable dialog
that you can either activate when you need it, or keep around as a
tab in a dock. The "current gradient", used in most gradientrelated operations, is shown in the Brush/Pattern/Gradient area of
the Toolbox. Clicking on the gradient symbol in the Toolbox is an
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alternative way of bringing up the Gradients dialog.

Patterns
A pattern is an image, usually small, used for filling regions by
tiling, that is, by placing copies of the pattern side by side like
ceramic tiles. A pattern is said to be tileable if copies of it can be
adjoined left-edge-to-right-edge and top-edge-to-bottom-edge
without creating obvious seams. Not all useful patterns are
tileable, but tileable patterns are nicest for many purposes. (A
texture, by the way, is the same thing as a pattern.)

Screenshot

In GIMP there are three main uses for patterns:





With the Bucket Fill tool, you can choose to fill a region
with a pattern instead of a solid color.
With the Clone tool, you can paint using a pattern, with a
wide variety of paintbrush shapes.
When you stroke a path or selection, you can do it with a
pattern instead of a solid color. You can also use the Clone
tool as your choice if you stroke the selection using a
painting tool.

Palettes

Screenshot

A palette is a set of discrete colors. In GIMP, palettes are used
mainly for two purposes:
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 They allow you to paint with a selected set of colors, in the
same way an oil painter works with colors from a limited
number of tubes.

 They form the color maps of indexed images. An indexed
image can use a maximum of 256 different colors, but
these can be any colors. The color map of an indexed
image is called an "indexed palette" in GIMP.
Actually neither of these functions falls very much into the
mainstream of GIMP usage: it is possible to do rather
sophisticated things in GIMP without ever dealing with palettes.
Still, they are something that an advanced user should
understand, and even a less advanced user may need to think
about them in some situations, as for example when working with
GIF files.

Colormap
GIMP makes use of two types of palettes. The more noticeable are
the type shown in the Palettes dialog: palettes that exist
independently of any image. The second type, indexed palettes,
forms the color maps of indexed images. Each indexed image has
its own private indexed palette, defining the set of colors available
in the image: the maximum number of colors allowed in an
indexed palette is 256. These palettes are called "indexed"
because each color is associated with an index number. (Actually,
the colors in ordinary palettes are numbered as well, but the
numbers have no functional significance.)

Screenshot

Text and Fonts
One of the greatest improvements of GIMP 2.0 over GIMP 1.2 is in
the handling of text. In GIMP 2.0 and 2.2, each text item goes in a
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separate Text layer, and you can come back later to the layer and
edit the text in it. You can also move the text around in the image,
or change the font, or the font size. You can use any font available
on your system. You can control justification, indentation, and line
spacing.
Actually, you can operate on a text layer in the same ways as any
other layer, but doing so often means giving up the ability to edit
the text without losing the results of your work.

Screenshot

Files
The GIMP is capable of reading and writing a large variety of
graphics file formats. With the exception of GIMP's native XCF file
type, file handling is done by plug-ins. Thus, it is relatively easy to
extend GIMP to new file types when the need arises. Not all file
types are equally good for all purposes. This part of the
documentation should help you understand the advantages and
disadvantages of each type.
Creating new Files
You can create new files in GIMP by using the following menu
item: File New. This opens the Create a new image dialog, where
you can modify the initial width and height of the file or using the
standard values. More information about this dialog can be found
in.
Opening Files
There are several ways of opening an existing image in GIMP:

 Open File The most obvious is to open it using a menu, by
choosing File Open from either the Toolbox menu or an
image menu. This brings up a File Chooser dialog, allowing
you to navigate to the file and click on its name. This
44

Digital Imaging

method works well if you know the name of the file you
want to open, and where it is located. It is not so
convenient if you want to find the file on the basis of a
thumbnail.

Screenshot

Saving Files
There are several commands for saving images. A list, and
information on how to use them, can be found in the section
covering the File menu. GIMP allows you to save the images
you create in a wide variety of formats.

Screenshot

It is important to realize that the only format capable of saving
all of the information in an image, including layers,
transparency, etc., is GIMP's native XCF format. Every other
format preserves some image properties and loses others.
When you save an image, GIMP tries to let you know about
this, but basically it is up to you to understand the capabilities
of the format you choose.
Using the Quickmask
Open an image or begin a new document;
Activate the Quickmask using the left-bottom button in the image
window.
If
a
selection
is
present
the
mask is
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initialized with the content of the selection;
Choose any drawing tool. Paint on the Quick Mask using black
color to remove selected areas and white color to add selected
areas.
You can use grey colors to get partially selected areas. You can
also use selection tools and fill these selections with the Bucket Fill
tool. This does not destroy the Qmask selections!
Toggle off the Quickmask using the left-bottom button in the
image window: the selection will be displayed with its marching
ants.
Creating New Layers
There are several ways to create new layers in an image. Here are
the most important ones:
Selecting Layer New Layer in the image menu. This brings up a
dialog that allows you to set the basic properties of the new layer;
see the New Layer dialog section for help with it.
Selecting Layer Duplicate Layer is in the image menu. This creates
a new layer that is a perfect copy of the currently active layer, just
above the active layer.
When you "cut" or "copy" something, and then paste it using CtrlV or Edit Paste, the result is a "floating selection", which is a sort
of temporary layer. Before you can do anything else, you either
have to anchor the floating selection to an existing layer, or
convert it into a normal layer. If you do the latter, the new layer
will be sized just large enough to contain the pasted material.

Working with Digital Camera Photos
The Procedure
The basic technique is to create a layer above the image that
contains the other exposure of the same scene. Finally, apply a
layer mask to the thin layer which makes parts of the image
transparent to shown in image below.
Step 1
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Screenshot

Here are the two exposures, loaded into GIMP. Sandwich these on
different
layers
and then
combine
them
with
a
layer
mask.
Step 2
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Screenshot

Screenshot

The first decision is which one goes on top. In this case the
decision is to put the lighter image on top and the darker one on
the bottom. The reason is because is that these are hand-held
shots, and are far from aligned. Move the bottom image until the
arch is aligned as best.
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Go the image that is going to be on the bottom. Open the Layers
dialog (Ctrl+L) and click on the new layer button ( ) to create a new
layer.
Step 3

Screenshot

Screenshot

Go to the image that is going to be on top. Select all and copy
(Ctrl+Athen Ctrl+C).
In the Layers dialog, make sure the new layer is selected, then go
to the bottom image window and paste (Ctrl+V). In the Layers
dialog, click on the anchor button (
) to anchor the
floating image.
Step 4

Screenshot
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Crank down the opacity of the upper layer so that you can see
both images.
If, they are perfectly aligned you can skip the next step. Unless you
used a digital capture on a tripod, the images probably need to be
aligned. (Even if you had a film camera on a tripod, it is difficult to
get two successive scans to feed through in perfect alignment.)
Step 5

Screenshot

Screenshot

In the Layers dialog, select the layer you need to move or rotate.
In this case it is the lower layer. Using the arrow keys, nudge the
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image into alignment. You may need to rotate the image slightly
too. When you get close to alignment, zoom in to get a good
close-up view and get the best possible fit.
Step 6

Screenshot

In the Layers dialog, right-click on the upper layer and select Add
Layer Mask. In the Add Mask Options dialog, select White (Full
Opacity) and click OK.
Step 7

Screenshot
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Screenshot

Now, to paint black (transparency) onto the layer mask wherever
we want the lower image to show through.
To minimize painting time, use the hand-select (“lasso”) tool to
select a large, hand-drawn region just inside all the borders of the
area you want to paint, as shown at right. Then using the fill tool
fill the selection with black.
Step 8

Screenshot
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Screenshot

Next, select a large opaque brush from the Brushes dialog
(Dialogs/Brushes), select the Paint tool and begin painting into the
mask close to the boundaries of the blend.
Notice that we still have the opacity cranked down on the upper
layer so that I can see both layers.
Step 9

Screenshot
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Screenshot

For the very edges, switch to a small, feathered brush and very
carefully paint the edges.
While painting, zoom in and out frequently (“=” key to zoom in, “-”
key to zoom out) to inspect the work. Don’t worry too much about
the borders, since we’ll probably have to touch those up anyway.
Step 10

Screenshot
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Now the most painstaking part: blending the seams. This is a little
tricky due to the different tonalities of the two exposures.
For blending work, the Clone ( ), Smudge ( ), Airbrush ( ) and Blur (
) are my tools of choice.
Since not sure if these tools have the ability to work across layers
(as they do in Photoshop), duplicate the image (Ctrl+D) and flatten
the duplicate (Layers -> Flatten Image) and work on it. This has the
additional benefit that if ever mess up the blending job too badly
can always easily start over at this step.
Note: see this tutorial on correcting blown out highlights for
another example of using these tools for blending and some useful
tips on their use.
Here we have used primarily clone and a touch of smudge to
blend the seams of the two exposures.
Note: notice the chromatic aberration of the lens in the form of
purple fringing at the edge of the arch. These tools are great for
dealing with that even if I were not blending two exposures.
Final Step

Screenshot

Finished

The image still has some problems with blown out highlights in the
sunlight of the rock face. It is also a little too dark in the
foreground shadow.
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Creating a Contrast Mask
Introduction
This tutorial will show you how to do create a contrast mask for
your image in GIMP.

Screenshot

A contrast mask allows you to reduce overall contrast,
simultaneously bringing out more detail in highlights and shadows.
This may be necessary to obtain a decent print, because prints on
paper do not have as much dynamic range as a monitor; if you
don’t control the contrast, detail in the highlights may blow out
and detail in the shadows can block up and become muddy or
even black. You can of course modify your image directly in GIMP
to decrease contrast, but the advantage of the contrast mask
technique is that it allows you much more precise control, and
gives better results.
The basic technique is to create a layer above the image that
contains a B&W negative of the image. The images are combined
in overlay mode: dark parts with light, light parts with dark. All the
while your original image remains blissfully unchanged on its layer.
Giving credit where credit is due: I did not come up with this
method. I adapted it for GIMP from a Photoshop tutorial on The
Luminous Landscape web site (great photography web site BTW; I
recommend it).
The contrast mask technique does some similar things for the
exposure as the digital split ND filter and the blended exposures
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techniques. If you feel your image have exposure problems you
might want to consider those techniques as well. Each one has
different strengths. Occasionally this technique gives unacceptable
color shifts in certain images. Sometimes it is just the ticket.
The Procedure
Here is the original example image, loaded into GIMP. The red
leaves are a little too dark to make out the detail; if printed, the
result would be pretty dark and muddy. At the same time, the
yellow flowers have a couple of specular highlights that would
probably blow out the detail if printed.
We want to brighten the dark areas a little and darken the light
areas a little. In other words, reduce contrast.
Step 1

Screenshot

Open the Layers dialog. Right-click on the Background layer and
select Duplicate (there is also a button for this in the bottom
button bar of the Layers dialog.
Step 2

Screenshot
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Screenshot

Now double-click on the duplicate layer and rename the new layer
“Contrast Mask”. (This step is not strictly necessary, but it is
helpful to prevent confusion about what is on each layer,
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especially if you add some additional layers for other editing
purposes).
Step 3
Screenshot

Select the Contrast Mask layer. Go to the image window and rightclick, selecting:
Image → Colors → Desaturate
Step 4
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Screenshot

Right-click and select
Image → Colors → Invert
You now have a B&W negative image of your original. We’re going
to combine this with the original (light with dark, dark with light)
to reduce the overall contrast.
Step 5

Screenshot

Go back to the Layers dialog and in the “Mode” drop-down box,
select “Overlay”. The result may look better in terms of contrast,
but degraded in terms of overall sharpness.
Don’t worry, we’re not done yet.
Step 6
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Screenshot

Screenshot

Go back to the image window and right click, selecting
Filters → Blur → Gaussian Blur
You will need to experiment to find the best value, but typically a
value between 10 and 30 will do nicely. After blurring the contrast
mask the overall image should now look much sharper.
Click on the “eye” next to the Contrast Mask layer in the Layers
dialog to rapidly compare the image with and without the mask.
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Similarly, turn off the Background layer if you want to view the
mask to do further work on it.
The image at top left is the original, the top right is with the
contrast mask.
Step 7

It is informative to see how this technique compares to the
conventional technique of using the contrast dialog to adjust
contrast. I’ve tried to adjust the contrast to have the leaves appear
about the same. I think the image with the contrast mask has a lot
more pop! This one looks kind of flat by comparison.
Step 8

Screenshot

To see why this is so, compare the histograms of the images. The
top one is for the original image, the middle is for the image with
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the contrast mask, and the bottom one is for the original image
with the conventional contrast adjustment.
Note how the typical contrast adjustment has lost a lot of values
at both ends, but the mask technique basically preserved the
entire scale.
Step 9

Screenshot

You’ll have to flatten the image if you are saving it to a typical
image format like TIFF or JPEG (but not if you are saving to GIMP’s
native XCFformat). To do that, right-click on the image and select
Layers → Flatten Image
Fine Tuning
Now that your contrast mask is created, it’s time to fine tune it.
Here are some things you can do:

 Use

the
“Opacity” slider in
the Layers dialog to
decrease the effect
of the contrast
mask overall.

 Apply Levels
or Curves to the
contrast mask to
open up the shadows or reduce the highlights further.

 Apply the dodge and burn tools to the contrast mask.
 Apply a layer mask to the contrast mask and use it to select
only parts of the contrast mask; e.g. if you only want the
contrast mask to apply to certain areas of the image (see
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my example of this below).
Tips

 See this article for some informative tests on the effects of
the Gaussian Blur step on the contrast mask.
Other Examples

Screenshot

Screenshot

With a contrast mask as described above. Notice how the sky has
recovered some blue, and the detail visible under the tree!
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Screenshot

Screenshot

Here’s an example of how this technique overlaps with the digital
split ND filter approach. Which do you prefer?
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Screenshot

Screenshot

With a digital split ND filter. (1st image)
With a contrast mask as described above, plus a layer mask with a
gradient fill, so the contrast mask is mostly applied to the area
below the cliffs. (2nd image)
Note particularly the change in the color of the cliffs and the light
part of the sky just above the cliffs, in the image using the full
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contrast mask (upper right). This shows how a contrast mask
affects all parts of the image, unless you selectively disable part of
the mask, as I did in the lower right. Note also that with the split
nd filter (lower left) I was able to brighten the foreground more; I
could apply a general levels tweak to the contrast mask to achieve
the same thing, but it seems like more work. This illustrates a
general point for me: the digital split ND filter technique is the
easier approach when you’re already satisfied with half of the
image, whereas the contrast mask is a better starting point if the
overall image needs contrast reduction on both the dark and light
sides.

Layer Masks
Layer masks are a fundamental tool in image manipulations. They
allow you to selectively modify the opacity (transparency) of the
layer they belong to. This differs from the use of the layer Opacity
slider as a mask has the ability to selectively modify the opacity of
different areas across a single layer.
This modification of a layer’s transparency through a mask is nondestructive to the layer itself.
This flexibility to define the opacity of different areas of a layer is
the basis for more interesting image manipulation techniques such
as selective coloring and luminosity masking.
Adding a Mask to a Layer
Layer masks need to be added to a layer before they can be used.
The process for adding them is simple.
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Title-Colorization
Attribution- Pat David
Source- GIMP.org
Link- https://www.gimp.org/tutorials/Layer_Masks/

Layers dialog for the image.
For this example a simple image is used with only two layers, as
shown above. There is a base image at the bottom of the stack
and a single layer of teal over it. The teal layer is the active layer
(look for the white border), and the one which we will add a layer
mask to.
Right-Click on the layer you want to add a mask to (the “Teal”
layer in my example), and the Context menu will show an option
to Add Layer Mask…:
Add Layer Mask in the context menu.
You
mask

can also add a layer
through the menus:

Title-Colorization
Attribution- Pat David
Source- GIMP.org
Link- https://www.gimp.org/tutorials/Layer_Masks/

Layer → Mask → Add Layer Mask…
This will then bring up the “Add a Mask to the Layer” dialog with
some options:
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Screenshot

Add mask options
dialog.
There
are
many
options for initializing
the Layer Mask. Notice
that the first option is
to set the entire mask
to White, which will
result in full opacity on
the
layer
(no
transparency from the
mask). The option to
initialize to Black shows that the mask will make
the entire layer fully transparent.
For the purposes of this tutorial, we will let the mask initialize to
White (full opacity). You should notice a change in your Layers
dialog now that shows the layer mask thumbnail to the right of the
layer it applies to (in this case the “Teal” layer):
Layers dialog with mask applied to Teal layer.
The layer mask has now been added to the “Teal” layer. It is also
active (there is a white border around the thumbnail in the dialog,
but is not visible due to the mask being white as well) and ready
for modification.
Modifying a Layers Transparency with the Mask
At this point any operations performed on the canvas will apply to
the mask and not to any layers themselves. To illustrate how
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masks can affect its layers transparency, let’s paint!
Use the Rectangle Select tool to select roughly the top third of the
image, and I’ll fill this selection with black.
Tools → Selection Tools → Rectangle Select
Activating
the
Select** tool.

**Rectangle

Using the Rectangle Select tool,
select roughly the top third of the
image:
Top third of the image selected.
If you want to fill this selection with
black, but before you do you need to
make sure that the foreground color
is black. Click on the foreground color
in the Color area to bring up the
“Change Foreground Color” dialog:
Click the foreground color to change.

The “Change Foreground Color” dialog allows you to set the foreground
color. For this example set the color to black, RGB(0, 0, 0):
Change the color to black.

With
the
foreground
color set, you
can now use
the Bucket Fill
Tool to fill in
the selection.
Tools → Paint
Tools → Bucket
Fill
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Title-Colorization
Attribution- Pat David
Source- GIMP.org
Link- https://www.gimp.org/tutorials/Layer_Masks/

Activating the **Bucket Fill** tool.
You can now click inside the selection to fill it with the foreground color
(black). As soon as you do, you’ll be presented with a new view of your
image on the canvas:

Title-Colorization
Attribution- Pat David
Source- GIMP.org
Link- https://www.gimp.org/tutorials/Layer_Masks/

As you can see, filling the selected portion of the layer mask with
black resulted in that area having 100% transparency, showing the
layer below it.
If you Rectangle select a different area of the mask, you can fill it
in with a different shade of gray to produce a variable opacity. For
example, I will select a few different regions of the mask, and fill it
with different levels of gray:
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Title-Colorization
Attribution- Pat David
Source- GIMP.org
Link- https://www.gimp.org/tutorials/Layer_Masks/

If you examine the layer mask, you’ll see that there are different
levels of gray being applied (black to white, from top to bottom),
and their value is what determines the opacity of the layer.

Selective Colorization Example
A good example of the application of layer masks is doing selective
colorization of an image (selectively allowing color to show
through a mostly black and white image). Walk through how to
easily do this with an image from Mardi Gras 2013:

Title-Colorization
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Attribution- Pat David
Source- GIMP.org
Link- https://www.gimp.org/tutorials/Layer_Masks/

Start the process by duplicating the base image (Shift+Ctrl+D, or
Right-Click layer → Duplicate Layer). From the menu:
Layer → Duplicate Layer
Then desaturate the upper layer using:
Colors → Desaturate
Following the steps above, add a layer mask to the desaturated
layer and initialize it to White (full opacity). At this point, the
Layers dialog should look like this:

Screenshot

As before, set your foreground color to black. This time, rather
than filling selections, we are going to use the Paintbrush Tool to
paint areas of the image we want the color to show through from
the layer below.
I decided to paint the boy on the fence. Using the Paintbrush Tool
I painted over his shirt and head. This allowed those colors to
show through from the layer below. Here are the results after
painting:
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Title-Colorization
Attribution- Pat David
Source- GIMP.org
Link- https://www.gimp.org/tutorials/Layer_Masks/

Simple Selective Colorization Example
To illustrate what was done, here is the layer
mask I painted to achieve the above result:

Mask isolated to illustrate
Of course, you could have chosen a different color than black to create the
mask. If you wanted a slightly more muted color I could have painted with a
more middle gray vs. black:

Simple
Selective
Colorization Example
(painted with gray
vs. black).
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Basic Color Curves
Color has this amazing ability to evoke emotional responses from
us. From the warm glow of a sunny summer afternoon to a cool
refreshing early evening in fall, we associate colors with certain
moods, places, feelings, and memories (consciously or not).
Instead, we are going to take a look at the use of the Curves tool in
GIMP. Even though GIMP is used to demonstrate these ideas, the
principles are generic to just about any RGB curve adjustments.

You’re Pixels and You
First there’s something you need to consider if you haven’t before,
and that’s what goes into representing a colored pixel on your
screen.

Title-Basic Color Curves
Attribution- Pat David
Source- GIMP.org
Link- https://www.gimp.org/tutorials/Basic_Color_Curves/

Open up an image in GIMP.Now zoom in.
Nope - don’t be shy now,zoom in more! And there’s Nope - don’t
be shy now, zoom in more! And there’s your pixel. So let’s
investigate what goes into making your pixel.
Remember, each pixel is represented by a combination of 3 colors:
Red, Green, and Blue. In GIMP (currently at 8-bit), that means that
each RGB color can have a value from 0 - 255, and combining
these three colors with varying levels in each channel will result in
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all the colors you can see in your image.
If all three channels have a value of 255 - then the resulting color
will be pure white. If all three channels have a value of 0 - then the
resulting color will be pure black.
If all three channels have the same value, then you will get a shade
of gray (128,128,128 would be a middle graycolor for instance).
So now let’s see what goes into making up your pixel:
The RGB components that mix into your final blue pixel.
As you can see, there is
more blue than anything
else (it is a bluish pixel after
all), followed by green, then
a dash of red. If we were to
change the values of each
channel, but kept ratio the
same between Red, Green,
and Blue, then we would
keep the same color and
just lighten or darken the
pixel by some amount.

Curves: Value
So let’s leave your pixel alone for the time being, and actually have
a look at the Curves dialog. I’ll be using this wonderful image by
Eric from Flickr.
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Title-Curves Value
Attribution- Qsimple
Source- flickr.com
Link- https://www.gimp.org/tutorials/Basic_Color_Curves/

Opening up my Curves dialog shows me the following:
Colors → Curves…
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We can see that I start
off with the curve for
the Value of the pixels. I
could also use the drop
down for “Channel” to
change to red, green or
blue curves if I wanted
to. For now let’s look at
Value, though.
In the main area of the
dialog I am presented
with a linear curve,
behind which I will see a
histogram of the value
data for the entire
image (showing the
amount of each value across my image). Notice a spike in the high
values on the right, and a small gap at the brightest values.
What we can do right now is to adjust the values of each pixel in
the image using this curve. The best way to visualize it is to
remember that the bottom range from black to white represents
the current value of the pixels, and the left range is the value to be
mapped to.
So to show an example
of how this curve will
affect your image,
suppose I wanted to
remap all the values in
the image that were in
the midtones, and to
make them all lighter. I
can do this by clicking
on the curve near the
midtones, and dragging
the curve higher in the
Y direction:

Screenshot
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Screenshot
What this curve does is takes the values around the midtones, and
pushes their values to be much lighter than they were. In this case,
values around 128 were re-mapped to now be closer to 192.
Because the curve is set Smooth, there will be a gradual transition
for all the tones surrounding my point to be pulled in the same
direction (this makes for a smoother fall-off as opposed to an
abrupt change at one value). Because there is only a single point in
the curve right now, this means that all values will be pulled
higher.
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The results of pushing the midtones of the value curve higher
(compare to original).
Care should be taken when fiddling with these curves to not blow
things out or destroy detail, of course. We only push the curves
here to illustrate what they do.
A very common curve adjustment you may hear about is to apply
a slight “S” curve to your values. The effect of this curve would be
to darken the dark tones, and to lighten the light tones - in effect
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increasing global contrast on your image. For instance, if I click on
another point in the curves, and adjust the points to form a shape
like so:

A slight “S” curve
This will now cause dark values to become even darker, while the
light values get a small boost. The curve still passes through the
midpoint, so middle tones will stay closer to what they were.
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Slight “S” curve increases global contrast (click for original).
In general, it easiest to visualize in terms of which regions in the
curve will affect different tones in your image. Here is a quick way
to visualize it (that is true for value as well as RGB curves):
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If there is one thing you
take away from reading
this, let it be the image
above.
Curves: Colors
So how does this apply
to other channels? Let’s
have a look.
The exact same theory
applies in the RGB
channels as it did with
values. The relative
positions of the darks,
midtones, and lights are
still the same in the
curve dialog. The primary difference now is that you can control
the contribution of color in specific tonal regions of your image.
Value, Red, Green, Blue channel picker.
You choose which channel you want to adjust from the “Channel”
drop-down.
To begin demonstrating what happens here it helps to have an
idea of generally what effect you would like to apply to your
image. This is often the hardest part of adjusting the color tones if
you don’t have a clear idea to start with.
For
example,
perhaps
we
wanted to “cool”
down the shadows
of our image.
“Cool”
shadows
are
commonly
seen during the
day in shadows
out
of
direct
sunlight. The light
that does fall in
shadows is mostly
reflected
light
from a bluish sky,
so the shadows
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will trend slightly more blue.
To try this, let’s adjust the Blue channel to be a little more
prominent in the darker tones of our image, but to get back to
normal around the midtones and lighter.

Screenshot
Boosting blues in darker tones
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Screenshot

Now, here’s a question: If you wanted to “cool” the darker tones
with more blue, what if you wanted to “warm” the lighter tones
by adding a little yellow?
Well, there’s no “Yellow” curve to modify, so how to approach
that? Have a look at this HSV color wheel below:
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Screenshot

The thing to look out for here is that opposite your blue tones on
this wheel, you’ll find yellow. In fact, for each of the Red, Green,
and Blue channels, the opposite colors on the color wheel will
show you what an absence of that color will do to your image. So
remember:
Red → Cyan
Green → Magenta
Blue → Yellow
What this means to you while manipulating curves is that if you
drag a curve for blue up, you will boost the blue in that region of
your image. If instead you drag the curve for blue down, you will
be removing blues (or boosting the Yellows in that region of your
image).
So to boost the blues in the
dark tones, but increase the
yellow in the lighter tones,
you could create a sort of
“reverse” S-curve in the blue
channel:
Screenshot
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Screenshot

Boost blues in darks, boost yellow in high tones
In the green channel for instance, you can begin to introduce more
magenta into the tones by decreasing the curve. So dropping the
green curve in the dark tones, and letting it settle back to normal
towards the high tones will produce results like this:

87

Unit 3 Image Editing with GIMP

Screenshot
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Screenshot

Suppressing the green channel in darks/mids adds a bit of
magenta
(click for original).
In isolation, these curves are fun to play with, but think that
perhaps walking through some actual examples of color
toning/grading would help to illustrate what we are talking about
here. Choose a couple of common toning examples to show what
happens when you begin mixing all three channels up.
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Unit Summary

Summary

This unit introduced the Gimp and its various applications. We
learnt the use of GIMP tool to edit images professionally. It
discussed in details about GIMP Express which is used for minor
editing and GIMP Editor which is used as a professional image
editing tool. It elaborated the use of GIMP to edit image using its
various tools like Editing Masking, Colour adjustments, layer
masking, etc through tutorials.

Assessment

Assessment
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1. What is GIMP?
2. What are Layers?
3. What are the features & capabilities of GIMP?
4. What are the three different types of color channel?
5. What is Layer masks In GIMP? Give example.
6. What is the use of Bucket Fill Tool?
7. Select a photograph and adjust the colour toning & gradient
of that photograph using GIMP.
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Resources

Reading

1.
2.
3.
4.

https://docs.gimp.org/odftest/en.pdf
www.gimp.org
http://wwwcdf.pd.infn.it/localdoc/gum.pdf
All images saved from screenshot which are done manually using
the above editors.
5. Some materials referenced from Google. This website states, it is
not copyrighted, thus a free material.
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Unit 4
Techniques behind VFX
Introduction

involve the integration of liveactionimagery
footage is
andcreated or
Visual effects are processes by which
generated imagery to create
manipulated outside the context of a live action shot. Visual
environments which look
effects involve the integration realistic,
of live-action
footage
but would
be and
generated imagery to create environments
which
look realistic,
dangerous,
expensive,
but would be dangerous, expensive, impractical, or
or impossible
impossibleto
to
film. Visual
capture on film. Visual effectscapture
using on
computer-generated
effects
are
processes
used
imagery have recently become accessible to the independent
to manipulate
filmmaker with the introduction of
affordable imagery
and easy-toworld which is manipulated
use animation and compositing software. Visual effects are
in postproduction house.
processes used to manipulate imagery
is manipulated
This world
video which
will provide
a brief
in postproduction house. Visual effects
have
taken
over
the
kinds
overview of this course.
of imagery effect or processes which were once dominated called
Topic
YouTube l
specialeffects. Special effects are effects either created on the
camera or by CGI. Both of these processes are employed to take
Video 1 –Pipeline
https://youtu.be/Q
advantage of technology to make imagery
thatinisGraphics
impossible to
Methodology
YIiE
find in the real world or far too difficult
or may be dangerous.
Industries
Some shots may be expensive to achieve without the use of visual
or special effects.
Video 2 –Image Editing

Outcomes

https://youtu.be/Sy
4KU

Upon completion of this unit you will be able to:
Video 3 –VFX Production




Outcomes



Designing
Understand the techniques of VFX
Understand what is digital composting
Learn about Computer generated Imagery CGI
Learn importance of visual effects shots
Course outcomes
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Terminology
VFX:

Visual effects are processes by which imagery
is created or manipulated outside the context
of a live action shot.

Digital
compositing:

Digital compositing is the process of digitally
assembling multiple images to make a final
image, typically for print, motion pictures or
screen display. It is the digital analogue of
optical film compositing.

CGI:

It is the computer generated imaginary.

Chroma:

Chroma key compositing or chroma keying, is
a visual effects / post-production technique
for compositing
(layering)
two images or video streams together based
on color hues (chroma range).

Keying:

The portions of the video which match the
preselected color are replaced by the
alternate background video. This process is
commonly known as "keying", "keying out"
or simply a "key".

Terminology

Visual Effects
there were two major special effects categories, in the year
1990called as Opticaleffects or techniques such as multiple
exposures, glass shots, or mattes. Also in this category the effects
were also achieved through the optical printer, where footage
could be photographed. Even today the optical printing effects are
the basis for the software-based effects. The second category is
mechanicaleffects, which are effects created on set, in front of the
camera, such as with models, props, and make-up.
In the late 1980s, digital compositing developed. Compositing is
the demonstration of consolidating two diverse symbolism
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sources; a procedure that was once done on an optical printer is
currently upgraded with the more noteworthy control permitted
by PCs, at a significantly decreased cost. The mid 1990s saw the
start of wide utilization of what is regularly alluded to as CGI or
CG. CGI or PC produced symbolism consolidates the procedure of
activity with the utilization of photorealistic surfaces to make
characters, view, and whatever else the psyche can envision to
make what can't be shot.
In the present visual impacts world, two noteworthy
arrangements of systems are utilized to unravel generally issues.
Will the shot an executive needs be accomplished by producing
designs, joining distinctive wellsprings of film, or utilizing the two
procedures?

Digital Compositing
The utilization of advanced compositing has turned out to be so
ordinary in present day diversion that it will frequently go totally
under the watcher's radar. A case of ordinary compositing is your
TV meteorologist. Your meteorologist is remaining before a green
screen (or blue screen), which is expelled and supplanted with PC
created maps.

Green screens and blue screens are utilized as a part of a
procedure called chroma keying or shading keying. The utilization
of entering started in the 1930s when a meticulous concoction
process, beside a troublesome match up shooting process, was
utilized at an awesome cost of time and cash. Be that as it may,
with the utilization of video and advanced compositing, the
procedure has turned out to be speedy and cheap.
Basically, an on-screen character, or subject, is shot before a
screen that is either blue or green. The shading does not need to
be blue or green, but rather blue and green are utilized frequently
on the grounds that they are in the scope of hues most inverse to
human skin. Blue, the inverse of yellow, was the customary
decision, which changed over to green when advanced
compositing turned into the standard on the grounds that
computerized cameras react better to the higher luminance
estimations of green. At the point when a film or non94
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computerized camcorder is being used, blue is regularly favored.
Green is regularly utilized when a shoot happens outside due to
the sky.

The shading screen background would then be able to be
evacuated. At the point when film is shot digitally, data is put
away in discrete shading channels. These will be red, green, and
blue. Moreover, there is a fourth channel, the alpha channel. The
alpha channel controls the clarity of the shading channels, and in a
composite shot the compositor can determine the shading range
that will get either a decreased straightforwardness or evacuation.
At that point a different bit of film can be put behind the shading
keyed shot and the joined shot is done.
Keying isn't the main technique for utilizing the utilization of alpha
channels. The utilization of garbage mattes is frequently important
to help where shading keys are excessively troublesome. Garbage
mattes more often than not allude to the procedure of hand
drawing the zone that will have a decreased transparency. The
modifier "garbage" alludes to the way that it is typically brief or
utilized as a feature of another procedure.
At the point when this isn't utilized as an impermanent or assisted
measure, the compositor is said to masking. The motivation
behind why this procedure isn't utilized more frequently than
shading (colour) keying is because of the way that it more often
than not requires alteration frame by frame. Considering film
(footage) with a hand-drawn process frame by frame is referred as
rotoscoping. .Rotoscoping is the way toward reshaping a matte,
however it can likewise be utilized to portray a shot that
incorporates a hand-drawn or balanced system that requires
consideration for every individual edge. In this way, some speedy
math, a motion picture has 24 frames for each second (fps) while a
TV show or business has around 30 fps. Indeed, on a 30-second
commercial that would be 900 different images that a rotoscoper
must take care of, which isn't generally alluring in the snappy pivot
entertainment surrounding we live in. The digital or computerized
compositing world comes furnished with little partners to lessen
the requirement for rotoscoping. Motion tracking is one of the
example within this. A territory of a picture can be recorded or
tracked by the PC with the goal that some different procedure can
be utilized to that region. For instance, in the Digital
Dismemberment, we can paint out and supplant half of a
performing artist's arm. To abstain from rotoscoping, we can put a
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dark spot with a marker on our on-screen character's arm so that
the PC can track and afterward something could be joined to that
point in its place.

Computer-Generated Imagery
Frequently joined with compositing, the other classification of
strategies used to take care of most visual impacts issues is the
production of CGI or CG. What this will involve is either assembling
a few 2D or 3D dimensional digtal (computerized) models that,
dissimilar to live performers or actual real locations or scenes can
be changed and moved effectively around to accomplish the
coveted scene.
While the utilization of CGI scenes started in the late 1970s, what
denoted the entry of what has turned out to be exceptionally
regular in the present visual impacts is the 1993 super hit film
Jurassic Park where CGI dinosaurs were convincingly incorporated
into scenes with live performing artists. Presently, that isn't the
special case, it's the standard.

Frequently, not simply Pixar characters but rather even sets,
helicopters, structures like buildings, and blasts are ordinarily
made using PC produced graphics that are composited into
scenes. This unit will talk about the procedures for making 2D and
3D designs in After Effects and also Apple's Motion and Autodesk's
Combustion, however these projects can just begin to expose
what's underneath of the 3D illustrations world, as there are many
devoted projects to create and animating 3D characters and
universes.

Three-dimensional character movement has to a great extent
supplanted the conventional hand-drawn animated characters. In
dream type films, for example, the current Star Wars prequel set
of three, 300, Sin City, and the Lord of the Rings set of three,
performing artists were for the most part shot in blue or green
rooms to have 2D-and 3D-rendered sets supplanting the screen
foundations. The simplicity of control and the scope of
conceivable outcomes have made 3D-rendered sets a perfect
decision over the antiquated arrangement of utilizing scale
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models. Notwithstanding when scale models are picked by the
generation groups, 3D graphics are utilized to improve the models.

Particle systems are utilized to reproduce regular marvels, for
example, smoke, fire, rain, snow, and tidy. Basically, similar to a
streaming wellspring of pixels, these particles can be controlled to
react to true material science at the tact of the VFX craftsman.

The under realized Power of Available Software
A standout amongst the most generally utilized instruments by
VFX craftsmen is something you likely have on your PC as of now,
Adobe Photoshop. Initially composed by Thomas Knoll while he
was a doctoral scholar, the thought got the consideration of his
sibling John Knoll, he has worked in Industrial Light and Magic.
John Knoll has turned into a academy award winner and
foundation grant champ for his VFX job away at the current Pirates
of the Caribbean films and is perceived for his work on numerous
different movies that depend on VFX.

Be that as it may, notwithstanding Photoshop's heredity as having
an association with the universe of visual impacts, it has viable use
as an instrument for VFX specialists. Thought to be the
establishment programming for altering any picture on a PC, it's
frequently utilized as a part of conjunction with Adobe After
Effects. Eventual outcomes reads the different layers of a
Photoshop archive and enables the client to apply keyframe style
animation of liveliness to them. For painting style impacts, clients
will alter pictures from After Effects in Photoshop to have an
advantage of Photoshop's unequaled quality with painting
instruments and after that arrival the picture to After Effects. The
first vision of programming creators of After Effects was to take
what Photoshop does and put it on a course of events.

Beside Adobe, Apple has filled their PCs with an awesome number
of stunning, proficient programming packages. Apple's Final Cut
Pro Studio began as an elective editing framework that
overwhelmed the postproduction world. Numerous VFX shots that
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once would have required an excursion apart from an editing
package can be executed in Final Cut Pro, which utilizes a
comparable key framing engine to After Effects. Sparing time and
cash numerous VFX issues would now be able to be settled in a
similar program that the editing may happen in.

Apple presented Motion in 2004, which later turned out to be a
piece of the Final Cut Studio. Created at first to encourage ease
the need to leave the Final Cut condition, Motion has developed
into a proficient contender to After Effects. It has a few
impediments, so it's not exactly a genuine trade for AE till now; be
that as it may, it has the solid preferred standpoint of tight
combination with Final Cut. These projects are ordinary among an
assortment of clients, however frequently their actual potential
goes unnoticed in light of the fact that the client doesn't know the
procedures to take genuine preferred advantage and support of
these projects.

Preparing for your visual effects shot
Here we will examine tips and strategies for setting up a VFX shot.
The measure of time spent in preproduction can spare significant
hours on the creation and days in postproduction.
An awesome case is like this something. Suppose you're taking a
shot at a shoot that requires a bright day, however in
preproduction the climate reports were not checked and it's
cloudy. So they waited over the set, for the mists to spread,
however the mists don't, so they shoot at any cost. Presently
regardless of numerous endeavours to cut around the cloudy film,
the editor needs the shot. A compositor is brought in to supplant
the mists and light up the recording to influence it to look right.
Contingent upon the shot, it may take lot of times altogether
however in the event that there's loads of movement, it may take
much more time. Presently, had the climate been checked, the
issue could have been worked around.

Presently every issue can't be expected, and plans must be worked
out. In any case, what ought to be maintained a strategic distance
from are things that can be dealt with effortlessly on the
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preproduction and production levels. You must have heard the
joke "we'll settle it in post?" Well, it's not a joke for all, and
keeping in mind that numerous issues can be settled in
postproduction, for what reason do that when it can be settled by
simply changing the framing or, even better, simply going into
production with a superior thoroughly considered arrangement.

Tips for VFX Artists in Preproduction
Let’s see a couple of tips on the best way to help your VFX shot
keep running as easily as could be expected.

Storyboard the Effect

Film scholars with storyboards don’t go together and they are like
oil-and-water association. It's terrible on the grounds that
arranging is entirely critical, and in the event that you can envision
it, early issues can be expected. We will see exhibit utilizing
Photoshop to make storyboards. There are some particular
favourable circumstances to storyboarding an impact carefully;
utilizing Photoshop you can think of something considerably
nearer to the last shot than stick figures.

Get Your Camera and Do a Test Shoot

It's really amazing that how could some postproduction people
don’t go from their workplace. On the off chance that you realize
that you have an impact shot coming up, for what reason not give
it a shot? Get the camera and make a test shot. You ought to have
some thought of what you would get and provide yourself the
chance to expect issues. It’s imperative that the shot be hand-held
or bolted off? Is lighting may be an issue? Will you require track
focuses? The test film(footage) can be conveyed to VFX specialists,
can be tested,tried and utilized for something.

Show up on Set
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A few directors, if the shot will depend on an impact, will demand
a VFX individual being available amid the shoot. Enormous
spending Hollywood motion pictures do this, and there's no
purpose behind an independent to be any extraordinary.
Particularly if the VFX craftsman has done tests as of now, now
he/she can exhort or advise on how everything is being finished.
Knowing where the issues will shoot, you can yell to the director
that maybe a retake is all together, given obviously that the entire
team of production compliant to it as instances are there some
may or may not comply.
Research the Technique
At the point when given a visual impacts venture you ought to
have some thought regarding how to work on it. In spite of the
fact that, why stick to one process up to your basic knowledge,
when you have a universe of information readily available?

Browse the Google and complete a little snappy research. How do
individuals take care of this issue? On the off chance that you take
after a long-established system for making a specific impact or
effect, has the procedure changed?

Generally, character animation in After Effects was finished by
bringing the character into Photoshop, cutting every one of the
parts up into layers, and afterward bringing in each one of those
layers into After Effects, changing all the Anchor Points, and
utilizing a complex Parenting plan. Seem like a considerable
measure of work? It may be.
At the point when After Effects CS3 turned out, it appeared like a
minor update, off-base! One new impact has totally changed the
procedure of character animation, the Puppet Tool. Presently you
can have full control over a character on a solitary layer. Beside
the likelihood that you might not have the best procedure for
making an impact, the best methods frequently change.

Text effects
In 1994 when Seven was released, people were not just blown
away by the film itself, but also by the excellent titlesequence
100

Digital Imaging

designed by Kyle Cooper. Title sequences got a huge boost from
the enthusiasm for the one seen in Seven. It created a sense of
anticipation for the film that would follow; just by the title
sequence the audience became unnerved — like, okay what you
are about to see is like nothing you’ve seen before. In this section
you will see some tutorials on how you can give your film that
exciting boost that only the right title sequence can give.
Title Sequence Workflow

(Created by Author)
Even the most utilitarian, functional purpose-only title sequence
can have a little style and flair and bring up the level of your
production. However, there are ways of overcomplicating a title
sequence without some careful considerations for the workflow.
Ingredients:


The background images for the title sequence.
Text file with credits listed (in most situations, producers
will give the designer a text file with the credits listed).

Text Background Integration
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(Created by Author)

This technique has also been used on Heroes, but we’ve seen it a
lot in TV commercials. Basically we take generated text layers and
make them a part of the scene by taking advantage of 3D space.
Typically, actors will walk in front, or on top of our type to make it
feel more three-dimensional.
Ingredients:

Footage of actors walking in a fairly large space

Three-Dimensional Text

To get that big, triumphant
look, nothing does better than
3D text.

Fig 4.1 3-Dimensional text

The new glass shot
A glass shot is a strategy that is to a great degree low tech yet
exceptionally viable. Basically, when a movie makerwants to
include landscape components and its cost is too high to create
set pieces, movie producers would paint the required additional
view on a sheet of glass and shoot the performing artists with the
glass specifically before the camera. Sounds enchanting and
curious, isn't that so? Surprisingly, This procedure was very basic
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at present. In any case, now, on account of computerized digital
compositing programming, shots that used to utilize these glass
strategies can be balanced carefully with more accuracy and more
prominent capacity.

The visual impacts methods talked about here are not intended to
hit the watchers beyond understanding; apart these systems not
upset the scene. In the wake of taking in these strategies, it's
really amazing that how frequently these are utilized and regularly
goes unnoticed. On the off chance that the impact is perfectly
done, the viewers never loses that suspension of doubt, and these
are presumably a portion of the most straightforward to pull off
without demonstrating the hand of the VFX artists excessively.

Modifying a Building

Fig 4.2 Modifying building(Created by Author)
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Amid creation on a movie, movie makers are regularly in the
circumstance of requiring an outside shot that is not existing.
Suppose we need to make a world with large messages to our
hero so how about we add a bulletin or hoarding to the highest
point of a working in Photoshop.
Requirements:


A master shot of the building that ought to be adjusted.
Another shot with the components to be added to the
building.

Adding Reflections to a Shot

Regularly hard to shoot, shots containing a reflection can include a
little punch and significance to a specific scene. The objects that
are reflective will frequently require the hand of the visual impacts
specialists to make the shot land precisely as it should.
Requirements:-

104



A master shot of the scene consisting of the reflective
surface



A second shot utilized on the surface that is reflective to
demonstrate the reflection we need (this is discretionary as there
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will probably be circumstances where the shot as of now contains
what we have to reflect)

Sign Replacement
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Fig. 4.3 Sign Replacement

(Created by Author)

Signs can be hazardous or a lifeline with regards to building up an
location. Signs can be utilized to set a state of mind and recognize
an area for a group of people. On the off chance that a sign is
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inadequately found or wrong for a film, frequently it should be
supplanted. Presently VFX craftsmen make the suitable sign for a
scene to catch the mind-set splendidly..
Requirements:


A master shot of the sign that will be changed.
A graphic of a new sign (which will be created in
Photoshop).

Removing Objects from the Frame

(Created by Author)
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Fig. 4.4 Removing objects from frame.

Regardless of how thorough the moviemaker, the
photography director, the area scout, and the entire crew are
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there will without a doubt be shots that have subjects in the frame
that ought not to be there and can be evacuated.
Requirements:

Footage with aitem that necessities evacuating

Changing the Weather
Numerous creations just advances or proceeds at the impulse of
the climate. By and large, in the event that we have a movie maker
who's justified regardless of his or her salt they will plan the shoot
so it happens in the suitable area with pleasing climate. On the
other hand, the climate can change on a dime. Fortunately the
VFX craftsman can, much of the time, change the climate. Be that
as it may, it's only one out of every odd case.
Requirements:


Footage of the shot that needs its weather changed.
Replacement footage for the sky. (if needed)

Fig. 4.5 Turning an Overcast Day into a Sunny Day

(Created by Author)
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Fig. 4.6 Turning a Sunny Day into a Rainy Day

Removing an Actor from the Frame

Fig. 4.7 Removing an Actor from frame

It is a typical understanding among editors, like that of magicians,
to demonstrate the group of viewers something required to
converge their attention regarding one place with the goal that
they will be diverted by something unique. Sometimes we may
have a great shotthat will be the best regardless of differences in
the position of things. Here's is a suggestion of managing that,
concealing the confusion.
Requirements:


Footage of the shot that requires a new or innovative focal
point.
Footage or still photo that may be utilized to mask or hide
something.

Horror effects
Some folks love to view movies of horror. There are few who are
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habituated to go for sleep after watching a horror movie. There
are numerous reasons why they adore ghastliness. The reasons
varyin various individuals. There are however the impacts of
watching frightfulness. A few people discover horror or
frightfulness fascinating and enjoyable to view. Others would not
set out watch films or even short clippings of this kind.
One reason why individuals appreciate watching ghastliness is the
story. As the story line of many horror movie is fascinating. The
thrills and suspense in the horror movies influence the viewers to
watch more movies like the same. These horror movies needs
great standards of direction. The horror movies director are
mindful so as to pick the best strategies utilized by the on-screen
characters in making the frightful or horror films more appealing.
The role or acting done in the film is additionally appreciated by
most of the audience. The fearlessness delineated by a few
characters in these stories inspire the majority of the audience.
Other individuals appreciate watching horror movies in light of the
thrilling component in the motion pictures and movies. The music
that is incorporated into the movies and horror films flicks
additionally persuades a few audience to continue viewing the
films. So all these features of horror movies make such movies or
motion pictures intriguing for the individuals who cherish viewing
the subject horror
Evil Eyes
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Fig. 4.11 Creation of evil eyes
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Fig. 4.12 Distorting facial features to create horror

A convention of the horror movie is Twisting the recognizable
soothing face into a beast. Here we will take a performer and give
him a quite irritating change. The eyes of a human is a standout
amongst the most particular highlights of a person has and a little
change in this marks a distinction and we could say that they have
been changed into a beast.
Requirements:

Footage of a performing artist whose eyes we will
supplant..



Large resolution still photograph of one of the performing
artist's eyes, ideally a digital macro lens close-up

Zombie Faces
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Fig. 4.13 Creating Zombie faces

Till now you have gone through the tutorials to make someone beautiful
or look attractive using a Photoshop. Now let’s see how to make a face
look absolutely frightening or terrific.
Requirements:

A shot of the performing artist whose face will get our beast
make-up.

Digital Dismemberment
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Fig. 4.14 creating digital dismemberment

At some point or another, in most great slasher flicks, somebody
lost an appendage. Here's an approach to subtract an arm, finger, or
leg with a little cautious arranging and some VFX enchantment..

Action effects
As per the historical background, activity motion images have
inferred two things: extensive blasts and more noteworthy
spending designs. These motion pictures are frequently called as
"idealist" or "popcorn" yet the activity type is furthermore very
well picturized and shown in the world of cinema. In the present
action film, the VFX skilled worker is routinely required to finish
two critical things: save money on expensive objects, hard to-get
shots and extra stand-ins from the distinctive dangers of on-set
failures.

In the 1930s, most movement films were expected for period
pieces, with a similar number of sword fights as the present action
films rely upon gun duels. By the 1970s, the tide had swung to the
cruel and tumble, not bewildered of bowing the law cop flick. In
any case, the 1980s gave us the Stallone/Schwarzenegger/Willisstyle of over-the-principle one man against widespread trap of
mental oppressor's style that helped impact the action to film the
common style in Hollywood today. By the mid-1990s, another
move twisted up evidently self-evident, the effect of the Hong
Kong style of action film, which joined the class with awesome
"kung-fu" sort. To the dissident fresh motion picture maker, it has
been a serious class in view of its prerequisite for swollen
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spending designs.

The best in class official normally can't stand to detonate
automobiles, squash windows, affect Uzis, and have swarms of
winged animals (affirm, that one we can hold just for John Woo).
Since the mid-1990s, it has ended up being progressively standard
for movement films to VFX over certified impacts and traps to
shield movies from going course finished spending design. Look at
it thusly; there aren't over and over again that you can detonate a
set, should something turn out seriously. Low-spending action
films, for instance, Robert Rodriguez's El Mariachi, show that with
great keenness, and the instrument set, it's positively attainable.
Moreover, with some VFX charm, spending designs can be saved
and structures can regardless be detonated. We should encounter
various typical action film shots and how, with some extremely
low-fi VFX frameworks, a film can at introduce come in under
spending design.

Vehicle Explosions
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Creating vehicle explosions

(Created by Author)
There is a little piece of every one of us that gets some sort of
fulfilment about observing something detonate. Exploding
something, while at the same time adding much energy to a film,
can likewise kill a financial plan. Frequently a visual impact of a
blast can be a bit of frustrating, so here are a few hints on the
most proficient method to influence it to feel to some degree
persuading. Here's one strategy to make an extraordinary looking
blast.
Ingredients:

Footage of the vehicle you would like to blow up (shot with
the camera on a tripod).



Footage of the background or location where the vehicle
will blow up without the vehicle there.



Stock
footage
of
www.detonationFilms.com

Square

Flames

from

Building Fire
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Creating building fire

(Created by Author)
If we somehow managed to influence a best 10 to rundown of the
most widely recognized inquiries from scholars about After
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Effects, " How would I make fire? " would be a contender for the
main spot. In all seriousness, it bodes well; we favor that students
are more enthusiastic to learn so they should produce fire on a PC
than attempt to make genuine ones.
Requirements:

A master shot of the exterior of a building with windows
(we are going to add the fire and smoke)

Creating Realistic Gunplay
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Creating Realistic Gunplay

(Created by Author)
Aside from a good gunshot sound effect, you will also need a great
looking“muzzle flash” to give your chase scene a great sense of
shoot them-up gunplay.
Requirements:-
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Footage of our actor firing our prop gun.



Prop gun (Try spray painting a water gun black).

Digital Imaging

Stock shot of “ muzzle fl ashes ” (the one in use here comes
courtesy of www.detonationfilms.com, a great resource for
free and lowcost special effects stock footage)

Unit summary

Summary

This unit gave a brief introduction to VFX and its relevance in
today’s world. It discussed about digital composting and computer
generated imagery CGI. It also introduced the software’s used to
create VFX and elaborated various tools associated with VFX. It
explained the process to create different effects like an action
shot, a horror shot, changing weather, creating explosion, etc.

Assignment
1. What is digital composting?
2. What are computer generated imagery?

Assignment

3. What are blue screen and green screen, why are they used in
VFX?
4.

What is story boarding?

5.

What are the advantages of using VFX?

6. Why is VFX used instead of video shooting?

Resources
1. https://en.wikipedia.org/wiki/Visual_effects
2. Byrne, Bill. The visual effects arsenal: VFX solutions for the
independent filmmaker. CRC Press, 2012.
Reading
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